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IMPORTANT NOTE 
 

 
Read and understand this manual  prior to using this instrument. 
 
This instrument should be inspected and calibrated by qualified and trained  
technicians. 
 
This instrument has not been designed to be intrinsically safe. For your safety, 
DO NOT use it in classified hazardous areas (explosion-rated environments). 

 
    
     
 
INSTRUMENT SERIAL NUMBER: ______________________________________________ 
 
 
PURCHASE DATE: ___________________________________________________________ 
 
 
PURCHASED FROM: _________________________________________________________ 

 
 
 
 

WARRANTY POLICY 
 
 

YES Environment Technologies Inc. warrants this instrument to be free from    
defects in materials and workmanship for a period of two years, excluding      
sensors, from the date of purchase by the original owner. The sensors have a 
warranty period of one year from the date of purchase. If the product should  
become defective within this warranty period, we will replace/repair it at our   
discretion.  
 
The warranty status may be affected if the instrument has not been used and 
maintained as per the instructions in this manual or has been abused, damaged 
or  modified in any way. This instrument is only to be used for  purposes stated 
herein. The manufacturer is not liable for  auxiliary  interfaced equipment or  
consequential damage. 
 
Due to ongoing research, development and product testing, the manufacturer 
reserves the right to change specifications without notice. The information     
contained herein is based on data considered accurate. However, no warranty is 
expressed or implied regarding the accuracy of this data. 
 
All goods must be shipped to the manufacturer by prepaid freight. All returned 
goods must be pre-authorized by obtaining a return merchandise authorization 
(RMA) number. Contact the manufacturer for a number and procedures required 
for product transport.  
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NOTICES 
 
 

Copyrights: This manual is subject to copyright protection; all rights are reserved. Under 
international and domestic copyright laws, this manual may not be copied or translated, in 
whole or  in part, in any  manner  or format, without  the  written  permission of YES    
Environment Technologies Inc. 
 
All software which YES Environment Technologies Inc. utilizes and/or distributes, holds a 
proprietary interest and is also subject to copyright protection and all rights are reserved. 
No party may use or copy such software in any manner or format, except to the extent 
that YES Environment Technologies Inc. grants them a license to do so. 
 
 
 

REVISIONS 
 
 
This manual was written and published by YES Environment Technologies Inc. (the 
manufacturer). The manufacturer makes no warranty or representation, expressed or 
implied including any warranty of merchantability or fitness for purpose, with respect to 
this manual. 
 
Should you detect any error or omission in this manual, please contact the company at 
the following address: 
 
YES Environment Technologies Inc. 
Unit 145, 7391 Vantage Way 
Delta, BC V4G 1M3 
Canada 
 
Toll free:  1-800-663-5481 
Phone: 604-940-7007 
Fax: 604-940-7044 
E-mail: info@yestek.com 
Website: www.yestek.com 
 
In no event will YES Environment Technologies Inc., or it’s officers or  employees be  
liable for any direct, special, incidental or consequential damages resulting from any   
defect in any manual, even if advised of the possibility of such damages. 
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WELCOME 
 
 

Thank you for purchasing our YES-205 multi-sensor, indoor air quality monitor. The YES-
205 series of instruments are easy to use monitoring and data recording  devices for 
monitoring trends in air quality. 
 
The YES-205 is equipped with built-in (attached) temperature and humidity sensors to aid 
in verifying gas readings providing a comprehensive indication of indoor air quality. Data 
readings are stored in a built-in, self-powered, programmable data  logger with bullet-
proof memory to protect your data and a sample rate that is adjusted using the supplied 
software. The instrument may be hand-held, will easily stand on a flat surface, or fastened 
to a wall. 
 
The YES-205 series of instruments are manufactured with plug-in-play, interchangeable 
sensor modules to allow for multiple gas testing. The specifications listed in this manual 
indicate a wide array of sensors to choose from. These sensors may be changed in the 
field and operated in minutes.  
 
Calibration and repair is available at our manufacturing facility and through some of our 
authorized distributors. 
 
The YES-205 can reliably record time-based data, which can be downloaded via ACR 
Trend Reader software, onto any computer capable of running Microsoft    Windows 95 or 
higher (with an available serial communications port). 
 
If after reading through the manual, you have any questions, please do not hesitate to 
contact our service department for technical support. 
 
 
 

MODEL DESCRIPTIONS 
 
 
MODEL  DESCRIPTION 
 
YES-205  Three integral sensors: CO2, Temperature, Humidity 
 
YES-205-4 Four integral sensors: CO2, Temperature, Humidity, plus one 
     electrochemical toxic gas sensor 
 
YES-205-5 Five integral sensors: CO2, Temperature, Humidity, plus two 
     electrochemical toxic gas sensors 
 
Note-1: When ordering an instrument, specify which extra sensors are desired. 
              Eg: YES-205-5 c/w CO and NO2 sensor 
 
Note-2: See specifications section (pages 9 to 19) for list and specifications for 
              available toxic gas sensor options 
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YES-205 SHIPPING CHECKLIST 
 
 
This checklist ensures that you have received everything required to run your IAQ     
monitor / logger. If you do not receive any of the items listed below, contact the factory 
immediately: 
 
 

• YES-205 multi-gas monitor/logger 

• ACR TrendReader software 

• Communications cable 

• AC wall adapter 24V @ 400 mA 

• Pelican brand carrying case (after January 2,  2003) 

• Calibration accessories (hose & coupling) 

• Operation manual 

• Other specified accessories (please refer to original sales order and the comments 
below): 

 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
 
Date: __________________  Checked by: __________________________ 
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1.0  GENERAL 
 
 

The YES-205 is a battery powered, portable indoor air quality (IAQ) monitor - logger. A 
basic instrument includes a multi-line LCD alpha numeric display, audible alarm,         
rechargeable battery pack, built-in programmable data logger, three sensors (Carbon 
Dioxide, Temperature and Relative Humidity), carrying case and basic accessories. 
 
The user can add up to two additional sensor modules (electrochemical toxic gas and/or 
Oxygen) internally for a maximum of five internal sensors. Currently, a selection of up to 
fourteen sensors is available to choose from. Reference the   available  sensor list further 
on in this manual. 
 
 
 
2.0  SPECIFICATIONS 
 
 
Physical:  a) Dimensions: 7” (178 mm) Wide X 8.4” (213 mm) High X  
  2.2” (56 mm) Deep 
 
  b) Weight: 2.8 pounds (1.3 kg) 
 
Construction: Very rugged, powder painted aluminum with easily removed, 
  vented cover 
 
Power:  Internal: Rechargeable, lead acid battery pack 
  Continuous: Plug-in, 24VDC wall adapter 
 
Visual:  Back-lit, multi-line LCD alphanumeric display 
  Tactile keypad for user access 
 
Option:  Internal, automatic sample pump (for gas sensors only) 
  Note: For best accuracy, not suggested to sample for reactive 
  gases such as Chlorine, Chlorine Dioxide, Ozone or Ammonia 
 
 
 
Minimum System Requirements to Operate Data Logging Software: 
 

• Personal computer 

• A Pentium II class processor or better 

• 4MB RAM 

• A VGA monitor 

• An open COM port 

• A hard disk with at least 1 MB of available disk space. Additional space is required to 
store logger files and graph files. 

• Microsoft Windows 95 or higher 

• Mouse (recommended) 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

The YES-205 instruments use the Non-Dispersive Infrared (NDIR) method of detecting 
Carbon Dioxide. This method is based on the principle that Carbon    Dioxide absorbs 
infrared energy at uniquely characteristic frequencies. The technique involves determining 
the difference in infrared energy absorption over all wavelengths passed by the optical 
system between a gas sample cell, containing the Carbon Dioxide compound and a    
pre-set reference path. 
 
In the YES-205, a broad band infrared source emits energy, which is filtered, to   produce 
a narrow range of frequencies characteristic of the Carbon Dioxide absorption spectra. 
The “band filter” allows for only those frequencies that are  absorbed by Carbon Dioxide, 
to pass into the detector while blocking all other frequencies. Carbon Dioxide located in 
the gas-sample cell selectively absorbs   energy propagating to the detector. 
 
This change in energy is detected, amplified and sent to the signal-processing portion of 
the system. It’s measurement range of 5,000 ppm covers  the range required to monitor 
compliance  with ASHRAE or other    ventilation efficiency standards. 
 
Note: The CO2 sensor installed is specified to be accurate to within 5% of the reading. 
The unit has been designed to exhibit minimal output drift for long periods of time.     
However, annual calibration verification is strongly recommended to ensure the continued 
satisfactory performance of this device. 
 
 
CO2 SENSOR SPECIFICATIONS: 
 
Operating Principle:  Non-dispersive infrared (NDIR) 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0  -  5,000 ppm 
 
Resolution:  1 ppm 
 
Long Term Drift:  +/- 20 ppm 
 
Response Time:  <60 seconds for 90% step change 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 2 years, 1-year for best accuracy 
 
Operating Temperature: 0o  to + 50o C 
 
Operating Humidity:  0% to 95% non-condensing 
 
Operating Life:  10 years 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

CO SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 50 ppm (other ranges available) 
 
Resolution:  0.3 ppm 
 
Long Term Drift::  <2% / month in clean air 
 
Response Time:  t90 = < 25 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 50o C 
 
Operating Humidity:  15% to 90% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  H2 @ 400 ppm = < 50 ppm 
   C2H4 @ 100 ppm = < 90 ppm 
   Cl2 @ 5 ppm = < 2 ppm 
   H2S / SO2 = 0 
 
 
NO2 SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 5.0 ppm (other ranges available) 
 
Resolution:  0.05 ppm 
 
Long Term Drift::  <3% @ 3 months 
 
Response Time:  t90 = < 25 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 50o C 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

NO2 SENSOR SPECIFICATIONS, CONT’D….. 
 
 
Operating Humidity:  15% to 90% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  SO2 @ 20 ppm = < 1 ppm 
   H2S @ 20 ppm = -25 ppm 
   CO / NO = 0 
   H2 = 0 
 
 
TEMPERATURE SENSOR SPECIFICAITONS 
 
 
Operating Principle: Negative Temperature Co-efficient Thermistor 
 
Gas sampling method: Diffusion 
 
Measurement Range: 0o C to + 50o  C (32O to 122o F) 
 
Resolution:  0.1 
 
Long Term Drift::  +/- 0.5o C 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 1 year for best accuracy 
 
Operating Temperature: 0o C to + 50o  C (32O to 122o F) 
 
Operating Life:  3 years plus 
 
 
HUMIDITY SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Thin film capacitive 
 
Gas sampling method: Diffusion 
 
Measurement Range: 0o C to + 50o  C (32O to 122o F) 
 
Resolution:  0.4% rH 
 
Long Term Drift::  +/- 0.5o C 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 1 year for best accuracy 
 
Operating Temperature: 0o C to + 50o  C (32O to 122o F) 
 
Operating Life:  3 years plus 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

OXYGEN SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 25.0% Volume 
 
Resolution:  0.2% Volume 
 
Long Term Drift::  <3% @ 3 months 
 
Response Time:  t90 = < 10 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 50o C 
 
Operating Humidity:  5% to 95% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  CO2 @ 5% Volume = 0.5% Volume 
 
 
AMMONIA SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 100 ppm (other ranges available) 
 
Resolution:  1 ppm 
 
Long Term Drift::  <5% @ 6 months 
 
Response Time:  t90 = < 60 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 40o C 
 
Operating Humidity:  10% to 95% continuous, non-condensing 
 
Operating Life:  2 years 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

AMMONIA SENSOR SPECIFICATIONS, CONT’D….. 
 
 
Cross Sensitivities:  H2 @ 10 ppm = 0 
   CO @ 1000 ppm = 0 
   H2 @ 1000 ppm = 25 ppm 
 
 
 
CHLORINE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 5.0 ppm 
 
Resolution:  0.02 ppm 
 
Long Term Drift::  <5% @ 6 months 
 
Response Time:  t90 = < 60 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 40o C 
 
Operating Humidity:  10% to 95% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  H2S @ 10 ppm = -0.3 ppm 
   NO2 @ 10 ppm = 1.2 ppm 
   F2 @  1.0 ppm = 0.44 ppm 
   CO @ 300 ppm = 3 ppm 
 
 
CHLORINE DIOXIDE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 1.0 ppm 
 
Resolution:  0.02 ppm 
 
Long Term Drift::  <5% @ 6 months 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

CHLORINE DIOXIDE SENSOR SPECIFICATIONS, CONT’D….. 
 
 
Response Time:  t90 = < 120 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 40o C 
 
Operating Humidity:  10% to 95% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  O3 @ 0.1 ppm = -0.03 ppm 
   Cl2 @ 1 ppm = 0 dose <100 ppm min. 
   Phosphine @ 0.3 ppm = 0.3 ppm 
   Arsine @ 1 ppm = 0.8 ppm 
   CO @ 1000 ppm = 0 
   H2 @ 1% Volume = 0 
 
 
 
FLOURINE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 1.0 ppm 
 
Resolution:  0.02 ppm 
 
Long Term Drift::  <5% per month 
 
Response Time:  t90 = < 80 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: 0o  to + 50o C 
 
Operating Humidity:  15% to 90% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  H2S @ 1 ppm = -1.5 ppm 
   Cl2 @ 1 ppm = 1.3 ppm 
   NO2 @ 1 ppm = 0.05 ppm 
   O3 @ 0.1 ppm = 0.2 ppm 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

HYDROGEN SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 4000 ppm 
 
Resolution:  < 20 ppm 
 
Long Term Drift::  <10% @ 6 months 
 
Response Time:  t90 = < 60 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -40o  to + 40o C 
 
Operating Humidity:  5% to 90% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  Ethylene @ 500 ppm = 280 ppm 
   Isopropanol @ 1100 ppm = 180 ppm 
   CO @ 50 ppm = 6 ppm 
   SO2 @ 2 ppm = 0 
   CH4 @ 1% LEL = 0 
 
 
HYDROGEN CHLORINE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 30 ppm 
 
Resolution:  0.5 ppm 
 
Long Term Drift::  <3% / months 
 
Response Time:  t90 = < 70 seconds 
 
Warm Up Time @ 22o C 5- minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -20o  to + 40o C 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

HYDROGEN SENSOR SPECIFICATIONS 
 
 
Operating Humidity:  10% to 95% continuous, non-condensing 
 
Operating Life:  2 years 
 
Cross Sensitivities:  H2S @ 10 ppm = 2.75 ppm 
   SO2 @ 5 ppm = 2.5 ppm 
   Cl2 @ 5 ppm = 1 ppm 
   HCN @  15 ppm = 1 
   H2 @ 1% LEL = 0 
 
 
 
HYDROGEN CYANIDE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 30 ppm 
 
Resolution:  0.3 ppm 
 
Long Term Drift::  <5% / months 
 
Response Time:  t90 = < 40 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -40o  to + 40o C 
 
Operating Humidity:  5% to 95% continuous, non-condensing 
 
Operating Life:  1.5 years in air 
 
Cross Sensitivities:  NO2 @ 10 ppm = -12 ppm 
   Cl2 @ 5 ppm = -1 ppm 
   H2S @ 10 ppm = 0 
   SO2 @ 2 ppm = 0 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

HYDROGEN SULPHIDE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 50 ppm 
 
Resolution:  0.05 ppm 
 
Long Term Drift::  <2% / month 
 
Response Time:  t90 = < 20 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -40o  to + 50o C 
 
Operating Humidity:  15% to 90% continuous, non-condensing 
 
Operating Life:  1.5 years in air 
 
Cross Sensitivities:  SO2 @ 20 ppm = <20 ppm 
   C0 @ 400 ppm = <0.05 ppm 
   H2 @ 400 ppm = 0 
 
 
NITRIC OXIDE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 100 ppm 
 
Resolution:  0.1ppm 
 
Long Term Drift::  <2% / month 
 
Response Time:  t90 = < 10 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -5o  to + 40o C 
 
Operating Humidity:  20% to 90% continuous, non-condensing 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

NITRIC OXIDE SENSOR SPECIFICATIONS, CONT’D….. 
 
 
Operating Life:  2 years in air 
 
Cross Sensitivities:  NO2 @ 100 ppm = <0.01 ppm 
   H2S @ 10 ppm = 0 
   SO2 @ 50 ppm = 0 
   CO @ 1000 ppm = 0 
 
 
 
OZONE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 1.00 ppm 
 
Resolution:  0.02 ppm 
 
Long Term Drift::  <5% / month 
 
Response Time:  t90 = < 60 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -10o  to + 40o C 
 
Operating Humidity:  10% to 95% continuous, non-condensing 
 
Operating Life:  1.5 years in air 
 
Cross Sensitivities:  H2S @ 1 ppm = <0.015 ppm 
   H2 @ 1% LEL = 0.003 ppm 
   Cl2 @ 1 ppm = 1.4 ppm +/- 50% 
   NO2 @ 1 ppm = 0.70 ppm 
   ClO2 @ 0.1 ppm = 0.12 ppm 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

SULPHUR DIOXIDE SENSOR SPECIFICATIONS 
 
 
Operating Principle:  Electrochemical 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0 - 20 ppm 
 
Resolution:  0.1 ppm 
 
Long Term Drift::  <2% / month 
 
Response Time:  t90 = < 25 seconds 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 6 months for best accuracy 
 
Operating Temperature: -30o  to + 40o C 
 
Operating Humidity:  15% to 95% continuous, non-condensing 
 
Operating Life:  2 years in air 
 
Cross Sensitivities:  H2S @ 20 ppm = 0.1 ppm 
   H2 @ 400 ppm = 0.2 ppm 
   CO @ 400 ppm = 0 
   NO @ 0 50 ppm = 0 
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3.0 INSTRUMENT EXTERIOR PHOTOGRAPH 

ENCLOSURE VENTS 
ALLOWING AIR AND 
TARGET GASES TO  

DIFFUSE TO  
INTERNAL SENSORS 

TEMPERATURE AND  
HUMIDITY SENSORS INSIDE  
POLYPROPYLENE DIFFUSER 

LEXAN LABEL WITH 
PROGRAMMING  

KEYPAD 

MULTI-LINE LCD  
ALPHANUMERIC DISPLAY 

RUGGED, ATTRACTIVE, POWDER PAINTED,   
ALUMINUM INSTRUMENT ENCLOSURE 
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3.1  INSTRUMENT BACK PANEL PHOTOGRAPH 

6.0” 
(152 mm) 

SERIAL NUMBER AND  
WARNING LABELS 

ARE ATTACHED 
HERE 

8.44” 
(214mm) 
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3.2 INSTRUMENT SIDE PANEL PHOTOGRAPHS 

PORT FOR FLOWING 
NITROGEN ZERO 

GAS AND CO2  
SPAN GAS 

SOCKET FOR 24V 
WALL ADAPTER 

SERIAL PORT FOR 
CONNECTION TO 

COMPUTER 

TEMPERATURE 
AND  

HUMIDITY SENSORS 
INSIDE  

POLYPROPYLENE 
DIFFUSER 

INSTRUMENT VIEW IS TO THE 
RIGHT OF THE DISPLAY 

INSTRUMENT VIEW IS TO THE 
LEFT OF THE DISPLAY 

2.18” 
(55 mm) 
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3.3  INSTRUMENT INTERIOR PHOTOGRAPHS 

TOXIC SENSOR MODULES IN 
THE MOUNTING BRACKETS 

RECHARGABLE LEAD 
ACID BATTERY PACK 

INFRARED CO2 
SENSOR 
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4.0 DISPLAY 
 
 
Temperature and relative humidity are displayed on the upper most line of the LCD     
display module. Carbon Doxide is displayed on the second line down in “ppm”, to a   
maximum of 5,000 ppm. Other toxic gases are displayed on the third and fourth line 
down, if these options have been purchased.  
 
The display can be temporarily turned off by pressing both arrow keys simultaneously for 
approximately 3 seconds, without interrupting the data acquisition process. The display 
can be reactivated by once again pressing both arrow keys simultaneously for             
approximately 3 seconds. The microprocessor indicator continues to flash in this mode. 
 
The microprocessor indicator (cursor at bottom right corner of display) shows that the 
instrument is successfully processing information. The square should blink approximately 
every 2 seconds. If the square remains constant and does not blink, it means the        
instrument is “locked up”. Turn the instrument off and back on again to reset the          
microprocessor.  
 
If the instrument purchased has one extra toxic gas sensor besides Carbon Dioxide, the 
graphic bar along the bottom edge of the display indicates remaining power left. A small 
arrow will indicate if the unit is powered by the internal battery (arrow pointing to the left) 
or the external AC adapter (arrow pointing to the right). 
 
If the instrument purchased has two extra toxic gas sensors besides Carbon Dioxide, a 
single arrow in the top right corner of the display, pointing to the right  Indicates the 24V 
AC adapter is powering the instrument. An arrow pointing to the left, followed by a single 
digit number (9=full charge, 0=flat battery) indicates the unit powered by the internal    
battery. Refer to the photo below. 
 
 
 
BACK-LIT, ALPHANUMERIC LCD DISPLAY 
 

BATTERY  -  CURSOR 
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4.1 KEYPAD 
 
 
ON / OFF KEY 
 
This key switches the instrument on and off. Hold the key in for approximately one      
second. 
 
MENU KEY 
 
This is the main key for navigating through the internal menu structure. 
 
ACCEPT KEY 
 
This keys allow the user to enter the various menu branches and also enter parameters 
into memory. 
 
ARROW KEYS 
 
These keys allow the user to toggle through the different settings of parameters and to 
select different options within the menus. 
 
 
 
KEYPAD 

4.2 EXTERNAL CONNECTIONS 
 
 
SERIAL PORT (COM PORT) 
 
This port allows the user to connect the instrument to the computer with the supplied 
communications cable to download recorded data. The cable attaches to any serial port 
on the computer. (Reference photos on page 22). 
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4.3 POWER JACK 
 
 
This allows the user to plug in the supplied 24V wall adapter to charge the internal battery 
or operate the instrument continuously for long periods of monitoring and recording.  
Without external power, the internal battery will operate the instrument for approximately 
10 hours, assuming you are starting with a fully charged battery. (Reference photos on 
page 22). 
 
Note-1: In order for the main battery to be properly recharged, the YES-205 must be 
plugged into the AC adapter for approximately 12 hours. 
 
Note-2: “Important Battery Life Information”; In order to preserve the life of the internal 
lead acid battery, DO NOT discharge the battery to 0% unless it is absolutely mandatory. 
70% maximum discharge is optimal. Please use only the  supplied AC adapter for this 
purpose. 
 
 
 
5.0 SYSTEM FLOW CHARTS 
 
 
 
MAIN MENUS 

MAIN DISPLAY 
SCREEN 

* FIRMWARE  
VERSION # 

*LOGGER SERIAL 
NUMBER 

ACCEPT 

MENU 

MENU 
FOR SECOND 

ELECTROCHEMICAL 
SENSOR SUCH AS 

NO2 

SYSTEM  
MENU 

CO2 
MENU 

MENU 
FOR FIRST 

ELECTROCHEMICAL 
SENSOR SUCH AS CO 

< MENU > 

ARROW UP ARROW UP 

ARROW UP 

ARROW UP 

After switch on, pressing the “ACCEPT” key displays the firmware version and logger 
serial number. Pressing the “ACCEPT” key again will reset all the minimum and        
maximum recorded values. Pressing the “MENU” key takes the user back to the main  
display screen. 
 
Pressing the “MENU” key from the main display screen enters the system menu screen. 
Pressing “▲” key allows the user to scroll up through the gas sensor menus and       
eventually back to the system menu screen. Pressing the “▼” key scrolls the user through 
the gas menus from the opposite direction.  
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5.0 SYSTEM FLOW CHARTS, CONT’D….. 
 
 
CO2 MENU 

CO2 
MENU 
U/D/ACC selects 
MENU exits 

CO2 ALARM 
DISABLED 
U/D/ACC selects 
MENU next item 

CO2 ALARM 
POINT 1200 PPM 
U/D/ACC selects 
MENU next item 

CO2 ALTITUDE 
UNITS METERS 
U/D/ACC selects 
MENU next item 

ACCEPT MENU 

MENU 

CO2 ALTITUDE 
        0 METERS 
U/D/ACC selects 
MENU next item 

CO2 ZERO CALIB’N 
SENSOR READY 
ACC starts 
MENU next item 

CO2 SPAN CALIB’N 
SENSOR READY 
ACC starts 
MENU next item 

CO2 
MENU 
U/D/ACC selects 
MENU exits 

MENU MENU 

MENU 

MENU 

Pressing “ACCEPT” while in the CO2 menu takes the user to the CO2 alarm screen 
(enable / disable). Pressing “MENU” at this point takes the user to the CO2 alarm screen 
(adjust the alarm set point up or down). Pressing “MENU” repeatedly scrolls the user 
through the various CO2 menus indicated above. 
 
 
 
CO MENU 

Pressing “ACCEPT” while in the CO menu takes the user to the CO alarm screen 
(enable / disable). Pressing “MENU” at this point takes the user to the CO2 alarm screen 
(adjust the alarm set point up or down). Pressing “MENU” repeatedly scrolls the user 
through the various CO2 menus indicated above. 

CO 
MENU 
U/D/ACC selects 
MENU exits 

CO ALARM 
DISABLED 
U/D/ACC selects 
MENU next item 

CO ALARM 
POINT 25 PPM 
U/D/ACC selects 
MENU next item 

ACCEPT MENU 
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5.0 SYSTEM FLOW CHARTS, CONT’D….. 
 
 
SYSTEM MENU 

MAIN DISPLAY 
SCREEN 

Temp xx 
Min xx 
Max xx 

R/H xx 
Min xx 
Max xx 

CO2 xx 
Min xx 
Max xx 

CO xx 
Min xx 
Max xx 

NO2 xx 
Min xx 
Max xx 

ARROW UP 

ARROW UP 

ARROW UP 

ARROW UP 

ARROW UP 

ARROW DOWN 

ARROW DOWN 

ARROW DOWN 

ARROW DOWN 

ARROW DOWN 
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6.0  INSTRUMENT OPERATION 
 
 
Press and hold the “ON/OFF” push-button on the front of the instrument, for                
approximately one second, to switch it on. The instrument “beeps” and the display will 
indicate “YES-205 INITIALIZING”. The display will indicate all installed sensors and their 
current values. Although the instrument immediately displays values for all installed    
sensors, allow the instrument to warm up for approximately 20 minutes for  maximum 
accuracy. CO2 and all other toxic sensors will be displayed as “ppm” (parts per   million). 
Temperature will be displayed as “C. or F.” (degrees C or F) depending which was      
selected and the humidity will be displayed as “%” (percent Relative Humidity). 
 
Pressing the “ACCEPT” button will display the version of the firmware installed, the serial 
number of the data logger installed and offer the user the option to “set min/max” (reset 
minimum and maximum) readings for all sensors. Pressing “ACCEPT” once more resets 
all the “min” and “max” readings. Resetting the “min / max” readings prepares the        
instrument  for a new sampling period in terms of  recorded minimum and maximum  
readings. Alternatively, pressing “MENU” exits this menu and takes you back to the     
normal sensor display screen. 
 
Pressing the “▲” arrow push-button allows the user to scroll through and display the “Min” 
and “Max” menus for all installed sensors. The display will first indicate “TEMPERATURE” 
and display the current, minimum and maximum readings.  Pressing the up arrow again 
takes you to the next sensor installed “REL HUMIDITY”. Pressing the up arrow again 
takes you to “CO2”. Subsequent pressing of the up  arrow button takes you to any      
additional installed toxic sensors such as “CO”, “NO2”, etc. 
 
Pressing the “MENU” button allows the user to scroll through the available menu        
functions. Pressing menu again exits this menu and takes you back to the normal sensor 
display screen. The display indicates “U/D/ACC selects”, “MENU exits”. Pressing “▲” (up 
arrow button) scrolls the user through the various menus available. Pressing “▼” (down 
arrow button) does the same but in the reverse direction.   Pressing “ACCEPT” allows the 
user to accept the displayed choice and enter that specific menu. 
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6.1 SENSOR MODULES 
 
 
The YES-205 series instruments are packaged with one internal infrared CO2 sensor and 
one externally mounted temperature and humidity sensor. They can also be packaged 
with one or two additional, internally mounted  electrochemical sensors for toxic gas    
detection. There are fourteen different sensors to choose from. The sensors are supplied 
installed internally at the time of order or as add-on (plug-in) devices.  
 
Depending on when the instrument was manufactured, it may contain “A” or “B”  series 
sensor modules or possibly even one of each. An “A” series sensor module is distinguish-
able by a round circuit board. A “B” series sensor module is distinguishable by a square 
circuit board. Both sensor modules plug-in the same and calibrate the same. 
 
 
“A” SERIES SENSOR MODULE       “B” SERIES SENSOR MODULE 

NOTE-1: INSTRUMENT MUST BE SWITCHED OFF BEFORE ATTEMPTING TO ADD OR 
REMOVE A SENSOR MODULE. UPON SWITCH ON IT WILL RECOGNIZE THE NEWLY  
INSTALLED SENSOR MODULE AND DISPLAY THE GAS TYPE AND CURRENT SENSOR 
READING. FOLLOW ALL THE INSTRUCTIONS ON THE NEXT PAGE. 
 
NOTE-2: THE “A” SERIES SENSOR MODULES ARE SHOWN ABOVE ONLY FOR           
REFERENCE PURPOSES. OVER TIME, THEY ARE SLOWLY BEING REPLACED WITH THE 
NEWER “B” SERIES SENSOR MODULES. 
 

SENSOR CONNECTIONS TABLE 
 
 
SENSOR TYPE  CONNECTION POINT ON MAIN BOARD 
 
CO2   P8 
TOXIC SENSOR-4  P5 
TOXIC SENSOR-5  P9 
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6.1 SENSOR MODULES, CONT’D….. 
 
 
To field install a sensor module, follow these steps: 
 
1) Switch off the instrument and remove the front metal instrument cover. Refer to figure-
1 photo. 
 
2) Locate the two, blue, pre-installed, sensor module cables. One is marked “4” and one 
is marked “5”, representing sensor number 4 and 5. Refer to figure-2 photo. 
 
3) Grasp the sensor module by the edges of the circuit board to avoid interfering with the 
circuit and potential damage and plug the sensor cable into it. These cables are keyed 
and insert only one way. Refer to figure-3 photo. 
 
4) Remove the gray plastic securing nut.  Gently insert the sensor module through the 
opening in one of the two aluminum mounting brackets and thread on the gray plastic nut. 
Align the module so the zero and span potentiometers are facing upwards for    
easier service access. Do not over tighten the nut. Refer to figure-4 photo. Typically if 
only one extra sensor is required, it is installed in the upper bracket position. 
 
5) Switch on the instrument, while pressing the “ACCEPT” key. Keep holding the 
“ACCEPT” key until 3 beeps and “LOGGER CONFIG UPDATED” message appears. 
Release the “ACCEPT” key. The instrument will recognize and display the gas type and 
current reading. Allow a warm up time of approximately 20 minutes for best accuracy in 
readings. 

TO REMOVE COVER, INSERT SMALL, FLAT BLADE              
SCREWDRIVER HERE AND GENTLY PRY OUTWARD 

FIGURE-1 

FIGURE-2 

4 

5 
PLUG-N-PLAY  
CABLES FOR: 

SENSOR-4 
SENSOR-5 



32 

6.1 SENSOR MODULES, CONT’D….. 

FIGURE-3 

FIGURE-4 
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7.0 CALIBRATION 
 
 
The sensors utilized in the YES-205 have a specific life span (refer to specifications sec-
tion) and require regular calibration throughout their life span to maintain best accuracy. 
The calibration procedures described on the following pages provide the user with step-
by-step instructions in how to achieve calibration of all sensors with the exception of tem-
perature and humidity. It is recommended that a trained technician perform these tasks.  
 
 
CO2 SENSOR (SENSOR # 3) 
 
 
Equipment required: 
 

• Zero gas  -  Nitrogen (N2) @ 99.9% Volume 

• CO2 span gas (Approx. 2000 ppm suggested) with balance N2 

• Calibration hose and fitting (supplied) 

• Cylinder regulator with pressure gauge and fixed flow rate of 0.2 LPM 
 
Note: A standard YES calibration kit is recommended 
 
 
Zero Calibration Procedure: 
 
 
1. Connect the brass fitting with hose attached to the threaded gas inlet port, located on 
the top left side of the instrument (with display facing you).  Reference the photo on page 
22.  
 
2. Thread the cylinder regulator onto the cylinder of Nitrogen and attach the calibration 
hose and fitting to the regulator. 
 
3. From the main system screen, press the “MENU” key once to enter the system menu. 
By pressing the up/down arrow key, locate the CO2 menu option and press the 
“ACCEPT” key. 
 
4. Scroll through the CO2 menu by pressing the “MENU” key. Once you see the CO2 
zero calibration menu, press the “ACCEPT” key. 
 
5. Open the regulator valve and flow zero gas (N2) at 0.2 LPM. 
 
6. Press the “ACCEPT” key, this will bring you to the zero initiation calibration screen. 
This screen will display the current CO2 zero ppm reading. Please wait until CO2 reading 
has stabilized (value not jumping by more than 1 to 3 ppm). 
 
7. Press the “ACCEPT” key to begin the zero calibration. 
 
8. At this point, you should be in the “CO2 zero calibration in progress” screen. The 
counter will begin to count down from 3:12. Please wait for the timer to elapse to 0:00 and 
“COMPLETE” is shown on the screen. Close the cylinder regulator on/off valve. 
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7.0 CALIBRATION, CONT’D….. 
 
 
9. Zero calibration is now complete, press the “MENU” key to enter the span calibration 
screen. 
 
 
Span Calibration Procedure: 
 
 
1. Remove the cylinder regulator from the N2 zero gas cylinder and thread it onto the  
cylinder of CO2 span gas. 
 
2. From the span calibration menu, press the “ACCEPT” key. 
 
3. By pressing the up/down arrow keys, enter the ppm (Approx. 2000) concentration of 
the cylinder of CO2 span gas that you are using.  
 
4. Once the ppm value has been entered, open the cylinder regulator and flow span gas 
(CO2). 
 
5. Press the “ACCEPT” key. Please allow the CO2 reading to stabilize (value not jumping 
by more than 1 to 3 ppm). 
 
6. Press the “ACCEPT” key to begin the span calibration. 
 
7. At this point, you should be in the “CO2 span calibration in progress” screen. The 
counter will begin to count down from 3:12. Please wait for the timer to elapse to 0:00 and 
“COMPLETE” is shown on the screen. Close the cylinder regulator on/off valve and    
remove the cylinder and brass fitting with hose attached. 
 
8. Once “COMPLETE” is displayed on the screen, press the “MENU” key twice to exit 
back to the main sensor display screen. The CO2 sensor is now calibrated. Remove the 
regulator from the cylinder for storage and remove the brass fitting. 
 
 
 
SENSOR  NUMBER FOUR AND FIVE  (ELECTROCHEMICAL TOXIC GAS SENSOR): 
 
 
Equipment required: 
 

• Zero air  -  Normal air with contaminates scrubbed out 

• Span gas (CO eg: 50 ppm suggested) with balance air 

• Calibration hose and fitting (supplied) 

• Cylinder regulator with pressure gauge and fixed flow rate of 0.2 LPM 
 
 
To calibrate this sensor, the front metal cover of the YES-205 must first be removed. To 
do this, insert a small flat blade screwdriver into one of the ventilation slots near the top or 
bottom edge of the cover and gently pry upward. Once the cover has been removed, the 
fourth and fifth sensor locations will be visible. Reference photo on page 31. 
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7.0 CALIBRATION, CONT’D….. 
 
 
The fourth and fifth toxic gas sensors are calibrated to the LCD display of the YES-205. 
 
1. Connect the brass fitting with gray coloured calibration adaptor attached, to the brass 
fitting on the end of the calibration hose.  
 
2. Thread the cylinder regulator onto the cylinder of zero air and attach the calibration 
hose and fitting to the regulator. 
 
3. Gently insert the gray calibration adapter into the opening in the front of the first  sensor 
module. Moisten the o’ring if it seems hard to insert. 
 
4. Open the on/off valve of the cylinder regulator and flow zero air over the sensor for 
approximately 1.5 to 2 minutes. The display should indicate “0”. If it does not, then adjust 
the “zero” potentiometer on the tiny circuit board of the fourth sensor until the display 
reads “0”. 
 
5. Close the regulator on/off valve and remove the cylinder of zero air. Attach the cylinder 
of calibration span gas (eg. CO at 25 ppm). Open the regulator on/off valve and flow span 
gas over the sensor for approximately 2 to 3 minutes or until the displayed value for that 
sensor has stabilized. 
 
6. Adjust the “span” potentiometer on the tiny circuit board of the fourth sensor until the 
display reads the same value as the span gas being flowed. 
 
7. Remove the regulator from the cylinder for storage and remove the calibration adapter. 
 
Note: Sensor number five (electrochemical toxic gas sensor) calibrates in exactly the 
same manner as indicated above. Use the calibration span gas cylinder acquired for this 
sensor. 
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8.0 DATA LOGGER OPERATION 
 
 
INTRODUCTION 
 
 
All YES-205 instruments are supplied with a powerful, built-in, programmable, 12-Bit data 
logger. The data logger is manufactured for YES by ACR Systems and utilizes the      
famous TrendReader software. The data logger will record data accurately and reliably 
over long deployment periods and in widely varying environmental conditions. 
 
TrendReader is the interface software that communicates with our data logger and   
transfers the recorded samples to a PC. The data can then be viewed as a graph file and 
exported to an Excel spreadsheet. The following section outlines the basic use of Trend 
Reader software. A more detailed description can be found on the Trend Reader manual 
on the supplied cd. 
 
Before being able to use the TrendReader software, it must first be installed onto the hard 
disk of your computer. Once TrendReader has been loaded on your PC, it allows you to: 
 

• Configure your YES-205 data logger 

• Display real-time values 

• Transfer logger values to your PC and create logger files 

• View and print graph files 

• Export graph files into databases or spreadsheets 
 
 
INSTALLING TREND READER FOR WINDOWS 
 
 
1) Start Windows 
 
2) Insert the Auto run CD ROM, supplied with your instrument, into your CD ROM drive. 
 
3) For manual installation explore the CD and execute the file “tsf1p31a”. The Trend 
Reader screen will appear. Click “ok” to continue, than follow the instructions on the 
screen. Once the installation is complete, move to the next step. 
 
 
 
USING TREND READER FOR WINDOWS 
 
 
Now that TrendReader has been installed, it can be started by clicking on the icon or 
going to start, programs, ACR data logger software, Trend Reader Standard, version-
1.31a 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
Screen Layout: The layout of the TrendReader screen is shown below: 

 
SETTING UP YOUR COMPUTER’S SERIAL PORT 
 
The Trend Reader software automatically detects an available COM port. No manual 
COM selection is required. 
 
 
DATA LOGGER SELECTION 
 
Click on “COMMUNICATE” tab on tool bar and select “PREFERRED LOGGER (RF)”. 
Select “4) SMART READER PLUS RF”. 

 
NOTE: When the instrument is switched off, the data logger continues to record valid  
temperature samples unless you attach the instrument to the computer and disable it. 
 
 
SETTING UP LOGGER TYPE 

 
 
 
 
From the 
Communicate 
menu click on 
“Preferred 
Logger (RF)” 
and Plus via 
select “4)
SmartReader 
RF” 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
CONNECTING THE YES-205 TO THE PC 
 
 
Ensure the YES-205 is switched off prior to performing the following connection. Connect 
the male end of the supplied DB-9 cable to the female connector of the YES-205, and 
connect the female end to an open 9-pin COM port on your PC. If your computer does not 
have a free 9-pin COM port, you can use a 9-25 pin gender changing adapter (available 
at most computer stores). At this point, switch on the YES-205 and allow it to initialize. 
 
To establish communication with YES-205, either click on the available COM port icon on 
bottom left corner of screen or select “COMMUNICATE” tab from tool bar and click on 
“OPEN COM ?” 
 

NOTE: THERE WILL BE  MORE COM PORT 
TABS ON THE SCREEN IF AVAILABLE IN 
YOUR PC. 

Once you click on “OPEN COM”, the software will start scanning the port for a        
connected YES-205. 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
CONNECTING THE YES-205 TO THE PC, CONT’D….. 
 
  
While the TrendReader software is attempting to establish communication with the   in-
strument, the YES-205 LCD display will indicate “REMOTE HOST MODE”. 
 
Once communication has been established, Smart Reader Plus dialogue box will appear. 
SMART READER automatically starts in real-time mode by default. 

NOTE: BEFORE ATTEMPTING TO 
CHANGE ANY SETTINGS, YOU MUST 
CLICK ON EDIT “SET UP” TAB TO 
TOGGLE TO SET UP MODE 

NOTE: BY CHECKING “STOP WHEN FULL” 
BOX, THE LOGGER WILL STOP SAMPLING 
WHEN IT IS FULL. YOU MUST CLEAR THE 
DATA BEFORE PROCEDING 

SETTING SAMPLE INTERVALS 
 
The software allows you to change sample rates on your YES-205 to suit the       require-
ments of your application. You can set up faster sampling rates to capture rapidly chang-
ing data or space out your readings to maximize memory and cover extended monitoring 
periods. To change the sample rate on your currently-connected YES-205, Click on 
“Sample Rate” and select desired sample rate. Note: Ensure that you are in “Edit Setup” 
mode before doing this. After every change please make sure to save setup. 
 
Click on Fast Read.          : 0.6 seconds 
 
Minimum Sample Interval:  8 seconds 
 
Maximum Sample Interval: 8 hours 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
DATA TRANSFER 
 
To transfer logged data from the YES-205 to  the PC, click on “Back Up” tab and the   
following dialogue box will appear. 

Data is transferred into a temporary memory location. The following dialogue box will 
prompt you to specify the file name and location to save the data for future reference. 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
DATA TRANSFER, CONT’D….. 
 
Once data has been saved to the specified location the following graph file will           
automatically open. Each channel will be displayed in a different colour for easier       
identification. 
 

WORKING WITH GRAPHS 
 
 
The Difference between Logger Files and Graph Files 
 
TrendReader usually follows the Windows style of handling files. There is, however, one 
important difference: how TrendReader distinguishes between logger file and graph files. 
 
Logger files 
When you copy a logger’s data to your computer using the backup function, TrendReader 
will automatically save all the data (internal and / or external channels) in one file.      
TrendReader calls this file a logger file and gives it a.TRW extension. 
 
 
Graph files 
 
When you open a logger file and choose one or more channels, a graph will be displayed. 
If you make any changes or add any comments to the graph give it a name and save it, 
TrendReader will save the graph as a graph file. It will give the file the .GPW extension to 
signify that it is a graph file. To find this file the next time, open the graph file dialog box. 
DO NOT move a logger file once it is created and saved. The graph file will not be able to 
find it and will not open. Try to move the logger file before you create any graph files. 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Never delete a logger file just because you have a graph file from the logger file’s data 
and you think that you don’t need the logger file anymore. A graph file cannot exist on its 
own. Every time you open a graph file it has to get data from its logger file(s) in order to 
open. 
 
To View Logger Data without altering it: 
 
If, when you open logger files, all you do is view the information (as a graph or table) and 
sometimes print the information, you don’t have to bother with graph files. When you have 
finished viewing or printing a graph or table, close it. If you want to look at it again, open 
that logger file again. 
 
As long as you don’t alter it and save it under another name, you can open and close a 
logger file as many times as you like. 
 
Opening Logger files to display graphs: 
 
When you open a logger file from the File menu, the Open Logger File dialog box will  
appear. 

TrendReader’s display of logger files in this dialog box departs slightly from the usual 
Windows style of displaying files. A logger file name is displayed in capital letters and the 
names of its channels are displayed below it in lower case letters. The dialog box above 
is displaying two of the sample logger files that come with the TrendReader software. The 
filename of the first logger is Eg. 57172.TRW. This file contains data from three external 
channels. It looks as if these channels are separate files, but they are not. They are all 
part of the file Eg. 57172.TRW. 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Opening Logger files to display graphs, Cont’d….. 
 
57172.TRW is the name that the user gave to the file, and “.TRW” is the extension that        
TrendReader gives to every logger file. 
 
Choosing logger channels for graphing 
 
TrendReader allows you to combine readings from different logger channels on a single 
graph. These readings can be from the same time period, from different time periods, 
from one logger, or from different loggers. 
 
To choose channels, open the Open Logger File dialog box from the File menu. In this 
box, a name in capital letters is a filename and refers to a logger. The information from 
the various channels of that logger is listed after the filename. All the data from a logger is 
in one file. 
 
From the Open Logger File dialog box: 
 
    To choose a single channel to display as a graph, click that channel and then click OK 
 
    To choose more than one channel, click the channels you want to highlight, and click       
    OK. You may choose channels from different loggers. 
 
     To choose all channels from one logger file (one logger), click the filename (all that                    
     file’s channels will be highlighted). Click OK  
    
     To deselect all channels from one file, click the filename. 
 
     To deselect any individual channel(s), click the channel(s) to remove the highlighting. 
 
When you have chosen the channel(s) you want to display as a graph, click OK 
 
 
Opening a Graph File 
 
If you have opened a logger file previously, made changes to the graph, given it a name, 
and saved it, the file is now a graph file. (The original logger file still exists.) 
 
To open this file again: 
 

1- From the File menu, choose Open Graph File. 
2- From the Open Graph File dialog box, choose the file you want. 
3- Click OK  

You can make changes to a graph file, but you cannot combine different graph 
files and display them as one graph. If you want to combine data from different 
logger channels or from different loggers onto one graph, you can do this only 
with logger files. Open logger File dialog box and combine your data from there 
by clicking on the channels you want to display on one graph. 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
A Graph Window 
 
Whether you have opened a logger file or graph file, your graph will be displayed in the 
graph window. 

The status bar 
 
The status bar, at the bottom of your screen, displays data relating to the coordinates of 
the cross hairs on the graph. As you move the cross hairs with the mouse you will see the 
coordinates changing on the status bar. 
 
Showing the legend 
 
The legend (the names of the channels that are displayed on the graph) appears to the 
right of the graph when there is a check mark in front of the legend on the View menu. 
 
Enlarging a graph Window 
 
When you open a graph file,the graph window will not be displayed at its maximum size. 
You can make it fill the whole screen by clicking the maximum button in the top right   
corner of the windows. 
 
The maximum button will become a restore button. 
 
Closing graph window [Ctrl+F4] 
 
To close a graph window, either press Ctrl+F4 or click the control-menu box in the top left 
corner of the window, and choose Close from the pull down menu. 

LEGEND 

GRAPH 
TITLE 

GRAPH 
FILE 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Zooming 
 
The zoom function magnifies the horizontal axis (the time axis ). It does not affect the 
vertical axis. The zoom function enables you to magnify a section of a graph so that you 
can see it in greater detail. The zoomed area becomes the full width of the graph,     
therefore the narrower the section you choose to zoom, the greater the magnification. 
 
There are two ways to zoom: by using the mouse, or by specifying the start and end time 
of the zoom from the Graph Zoom dialog box. You may zoom more than once. 
 

A. Using the mouse to zoom in on a section of a graph: 
 

1. Position the cross hairs to the left of the area that you want to     
magnify. (It doesn’t matter where you place the cross hairs vertically). 

2. Press and hold the left mouse button and drag to the right. The    
vertical lines that appear will be the boundaries of the magnified area. 

3. Release the mouse button when you have enclosed the area that you 
want to magnify. 

 
B. Using the Graph Zoom dialog box to zoom in on a section of a graph: 
 

1. Click anywhere below the graph. The Graph Zoom dialog box      
appears. 

2. Type the new time and date. Change AM or PM if necessary. 
                         3.     Click accept. 
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8.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Unzooming [Ctrl+Z] 
  
To view the graph at its original scale, go to the View menu and choose Unzoom X-Axis. 
 
 
Copying a graph to the clipboard [Shift+Ins] 
 
Copy a graph to the clipboard is an extremely fast and easy way of transferring a graph to 
another Windows application, for example, to a word processing program, where it can be 
included in a report. Copy Graph to clipboard is on the Edit menu. 
 
The clipboard ( a temporary storage area ) is a Windows feature; you can read about it in 
your Windows guide . 
 
As an example, we will transfer a graph to a word processing program. 
 

1. Open the graph that you want to place in the word processing program. 
2. From Edit menu, choose Copy Graph to Clipboard. 
3. Press Alt+Tab to transfer to Program Manager. 
4. Open the Accessories window and click Write. 

     5.     When the word processing program opens, choose Paste from the Edit menu.    
             The graph will be copied from the clipboard to the word processing program.         
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8.1 TROUBLE SHOOTING TREND READER SOFTWARE 
 
 
Why won’t Trend Reader Communicate with my logger? 
 
If logger does not respond when communication is attempted, check that: 
 

• The logger or modem is attached to the selected COM port 

• All connections are secure between the computer and the logger 

• There are no other applications using the COM port 

• Only one serial port is hardware configured for each COM designation 

• There are no conflicts IRQ assignments 
 
If the logger still does not work, try: 
 

• Testing the serial port with another application 

• The software on another computer 

• Other loggers or interface cable 
 
 
Why Won’t Trend Reader back up my logger? 
 
If the software cannot back up the loggers data, make sure there is enough room on the 
hard drive to store the data 
 
 
Why do my graphs have the wrong time and date on them? 
 
This happens if your computer clock is incorrect when you back up the logger. The Trend 
Reader depends on your computer having the correct time and date. If your graphs have 
the wrong time and date you can: 
 
Under Windows 95, 98, 2000 & XP: 
 

• Set clock on the computer by: 
 1. Double click on Windows time display in the bottom right corner of the 
      screen 
 2. On the date/time properties window, change the time 
 3. Click apply 
 

• Correct the original file by choosing “revise a logger file” from the option menu. 
Change the back up time/date to the actual time you backed up the logger. 
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8.1 TROUBLE SHOOTING TREND READER SOFTWARE 
 
 
How accurate are TrendReader time measurements? 
 
There are two answers to this question. The first answer describes the relative accuracy 
of each reading. The second answer describes the absolute accuracy of the reading. 
 
 
Relative Accuracy 
 
Relative time measurements in normal mode (the time that elapse between one reading 
and the next reading) are precise to within +/- 2 * sample rate/24 * 3600. The accuracy of 
the clock inside the logger is +/- 2 seconds per day. 
 
 
Absolute Accuracy 
 
TrendReader absolute time accuracy (the difference between the time the data logger 
took a reading and the time that TrendReader reports the reading was taken) depends 
upon the time base in the logger. The absolute time of TrendReader’s reading are       
accurate to within +/-4 seconds. 
 
When you back up your data, the logger is unable to tell TrendReader precisely when it 
stored it’s last reading. Trendreader only knows the current time and the elapsed time in 8 
second intervals.  
 
 
What rights are needed to run TrendReader on a  network? 
 
The method of granting rights varies according to which network operating system is be-
ing used. You should have the following rights: 
 

• Create 

• Erase 

• Search 

• Modify 

• Read 

• Write 
 
(or their equivalent) to both the TrendReader for Windows and the file path directory used 
to store data. 
 
 
Why can’t I print from TrendReader? 
 
1. Make sure the printer is powered and on-line by checking that it is plugged in and the 
associated lamps are on. 
 
2. Check that the printer cable is connected to the appropriate port on your computer. 
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8.1 TROUBLE SHOOTING TREND READER SOFTWARE, CONT’D….. 
 
 
Why can’t I print from TrendReader?, Cont’d….. 
 
3. Try the printer’s self-test function by clicking on start, settings, printers and right click 
on desired printer’s property. Click on print test page tab. If the printer fails the self test, 
contact your administrator. 
 
 
Why can’t I contact my data logger over the network? 
 
You probably don’t have SR+ network checked “on”. 
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